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into A’s? Obviously, right?
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Learn to use productivity apps!
Links to companion Sways, featuring 
videos with hands-on instructions, are 
located on www.cengagebrain.com.

© Rawpixel/Shutterstock.com

Productivity Apps for 
School and Work

Lochlan keeps track of 
his class notes, football 
plays, and internship 
meetings with OneNote.

Nori is creating a Sway 
site to highlight this year’s 
activities for the Student 
Government Association. Hunter is adding interactive 

videos and screen recordings 
to his PowerPoint resume.

Zoe is using the annotation 
features of Microsoft Edge 
to take and save web notes 
for her research paper.

Being computer literate no longer means mastery of only Word, Excel, 
PowerPoint, Outlook, and Access. To become technology power users, Hunter, 
Nori, Zoe, and Lochlan are exploring Microsoft OneNote, Sway, Mix, and Edge in 
Office 2016 and Windows 10.
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Introduction to OneNote 2016 ................. 2

Introduction to Sway ..................................6

Introduction to Office Mix ....................... 10

Introduction to Microsoft Edge .............. 14

OneNote 
Sway  
Of�ce Mix 
Edge

Corinne Hoisington
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Introduction to OneNote 2016
notebook | section tab | To Do tag | screen clipping | note | template | Microsoft  OneNote 
Mobile app | sync | drawing canvas | inked handwriting | Ink to Text   

As you glance around any classroom, you invariably see paper notebooks and notepads 
on each desk. Because deciphering and sharing handwritten notes can be a challenge, 
Microso� OneNote 2016 replaces physical notebooks, binders, and paper notes with a 
searchable, digital notebook. OneNote captures your ideas and schoolwork on any device 
so you can stay organized, share notes, and work with others on projects. Whether you 
are a student taking class notes as shown in Figure 1 or an employee taking notes in 
company meetings, OneNote is the one place to keep notes for all of your projects.

Bottom Line
•	 OneNote is a note-taking 

app for your academic and 
professional life.

•	 Use OneNote to get organized 
by gathering your ideas, 
sketches, webpages, photos, 
videos, and notes in one place.

Figure 1: OneNote 2016 notebook

Each notebook is divided into 
sections, also called section 
tabs, by subject or topic.

Personalize a page 
with a template, or 
stationery.

Pages can include 
pictures such as 
screen clippings, 
images from any part 
of a computer screen.

Attach files and 
enter equations 
so you have 
everything you 
need in one place.

Write or draw 
directly on the 
page using 
drawing tools.

Use To Do tags, icons that 
help you keep track of your 
assignments and other tasks.

Type on a page 
to add a note, a 
small window 
that contains 
text or other 
types of 
information.

Creating a OneNote Notebook
OneNote is divided into sections similar to those in a spiral-bound notebook. Each 
OneNote notebook contains sections, pages, and other notebooks. You can use One-
Note for school, business, and personal projects. Store information for each type of 
project in di�erent notebooks to keep your tasks separate, or use any other organiza-
tion that suits you. OneNote is �exible enough to adapt to the way you want to work. 

When you create a notebook, it contains a blank page with a plain white background 
by default, though you can use templates, or stationery, to apply designs in categories 
such as Academic, Business, Decorative, and Planners. Start typing or use the buttons 
on the Insert tab to insert notes, which are small resizable windows that can contain 
text, equations, tables, on-screen writing, images, audio and video recordings, to-do 
lists, �le attachments, and �le printouts. Add as many notes as you need to each page.

Syncing a Notebook to the Cloud
OneNote saves your notes every time you make a change in a notebook. To make sure 
you can access your notebooks with a laptop, tablet, or smartphone wherever you 
are, OneNote uses cloud-based storage, such as OneDrive or SharePoint. Microsoft  
OneNote Mobile app, a lightweight version of OneNote 2016 shown in Figure 2, is 
available for free in the Windows Store, Google Play for Android devices, and the 
AppStore for iOS devices.

If you have a Microso� account, OneNote saves your notes on OneDrive auto-
matically for all your mobile devices and computers, which is called syncing. For 
example, you can use OneNote to take notes on your laptop during class, and then 

Learn to use OneNote!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.
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open OneNote on your phone to study later. To use a notebook stored on your com-
puter with your OneNote Mobile app, move the notebook to OneDrive. You can 
quickly share notebook content with other people using OneDrive.

Taking Notes
Use OneNote pages to organize your notes by class and topic or lecture. Beyond sim-
ple typed notes, OneNote stores drawings, converts handwriting to searchable text and 
mathematical sketches to equations, and records audio and video.

OneNote includes drawing tools that let you sketch freehand drawings such as bio-
logical cell diagrams and �nancial supply-and-demand charts. As shown in Figure 3, the 
Draw tab on the ribbon provides these drawing tools along with shapes so you can insert 
diagrams and other illustrations to represent your ideas. When you draw on a page, One-
Note creates a drawing canvas, which is a container for shapes and lines. 

OneNote is ideal for taking notes 
during meetings, whether you are 
recording minutes, documenting 
a discussion, sketching product 
diagrams, or listing follow-up 
items. Use a meeting template 
to add pages with content 
appropriate for meetings. 

On the Job Now

Figure 2: Microsoft OneNote Mobile app

Notes synced to 
OneDrive and 
displayed on a 
smartphone 

Draw tab

Pens and 
highlighters 
are in the 
Tools group.

Insert text 
using the Type 
button in the 
Tools group.

Insert rectangles 
and lines from the 
Shapes group.

Lines and shapes are 
in the Shapes group.

Make drawings 
using pens in 
the Tools group.

Figure 3: Tools on the Draw tab

Converting Handwriting to Text
When you use a pen tool to write on a notebook page, the text you enter is called 
inked handwriting. OneNote can convert inked handwriting to typed text when 
you use the Ink to Text button in the Convert group on the Draw tab, as shown in  
Figure 4. A�er OneNote converts the handwriting to text, you can use the Search box 
to �nd terms in the converted text or any other note in your notebooks.
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Figure 4: Converting handwriting to text

Ink to Text button

Handwriting 
converted to 
searchable text

Writing inserted 
with a fingertip

Recording a Lecture
If your computer or mobile device has a microphone or camera, OneNote can record the 
audio or video from a lecture or business meeting as shown in Figure 5. When you record 
a lecture (with your instructor’s permission), you can follow along, take regular notes at 
your own pace, and review the video recording later. You can control the start, pause, and 
stop motions of the recording when you play back the recording of your notes.

Use OneNote as a place to brain-
storm ongoing work projects. If 
a notebook contains sensitive 
material, you can password-pro-
tect some or all of the notebook 
so that only certain people can 
open it. 

On the Job Now

Figure 5: Video inserted in a notebook

Math Lecture 
video file

Video recording

Record Video 
button

Audio & Video 
Recording tab
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Try This Now
1: Taking Notes for a Week
As a student, you can get organized by using OneNote to take detailed notes in your 
classes. Perform the following tasks:

a. Create a new OneNote notebook on your Microso� OneDrive account (the 
default location for new notebooks). Name the notebook with your �rst name 
followed by “Notes,” as in Caleb Notes.

b. Create four section tabs, each with a di�erent class name.
c. Take detailed notes in those classes for one week. Be sure to include notes, drawings, and other types of content.Take detailed notes in those classes for one week. Be sure to include notes, drawings, and other types of content.T
d. Sync your notes with your OneDrive. Submit your assignment in the format speci�ed by your instructor.

2: Using OneNote to Organize a Research Paper
You have a research paper due on the topic of three habits of successful students. Use OneNote to organize your research. 
Perform the following tasks:

a. Create a new OneNote notebook on your Microso� OneDrive account. Name the notebook Success Research.
b. Create three section tabs with the following names:

•	 Take Detailed Notes
•	 Be Respectful in Class
•	 Come to Class Prepared

c. On the web, research the topics and �nd three sources for each section. Copy a sentence from each source and paste 
the sentence into the appropriate section. When you paste the sentence, OneNote inserts it in a note with a link to the 
source.

d. Sync your notes with your OneDrive. Submit your assignment in the format speci�ed by your instructor.

3: Planning Your Career
Note: �is activity requires a webcam or built-in video camera on any type of device.

Consider an occupation that interests you. Using OneNote, examine the responsibilities, education requirements, potential 
salary, and employment outlook of a speci�c career. Perform the following tasks:

a. Create a new OneNote notebook on your Microso� OneDrive account. Name the notebook with your �rst name 
followed by a career title, such as followed by a career title, such as f Kara - App Developer.

b. Create four section tabs with the names Responsibilities, Education Requirements, Median Salary, and Employment 
Outlook.

c. Research the responsibilities of your career path. Using OneNote, record a short video (approximately 30 seconds) of 
yourself explaining the responsibilities of your career path. Place the video in the Responsibilities section.

d. On the web, research the educational requirements for your career path and �nd two appropriate sources. Copy a para-
graph from each source and paste them into the appropriate section. When you paste a paragraph, OneNote inserts it 
in a note with a link to the source.

e. Research the median salary for a single year for this career. Create a mathematical equation in the Median 
Salary section that multiplies the amount of the median salary times 20 years to calculate how much you will 
possibly earn.

f. For the Employment Outlook section, research the outlook for your career path. Take at least four notes about what you 
�nd when researching the topic.

g. Sync your notes with your OneDrive. Submit your assignment in the format speci�ed by your instructor.

Learn to use OneNote!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.
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Introduction to Sway
Sway site | responsive design | Storyline | card | Creative Commons license | animation 
emphasis e�ects | Docs.com 

Expressing your ideas in a presentation typically means creating PowerPoint slides 
or a Word document. Microsoft Sway gives you another way to engage an audience. 
Sway is a free Microsoft tool available at Sway.com or as an app in Office 365. 
Using Sway, you can combine text, images, videos, and social media in a website 
called a Sway site that you can share and display on any device. To get started, 
you create a digital story on a web-based canvas without borders, slides, cells, or 
page breaks. A Sway site organizes the text, images, and video into a responsive
design, which means your content adapts perfectly to any screen size as shown in 
Figure 6. You store a Sway site in the cloud on OneDrive using a free Microsoft 
account.

Bottom Line
•	 Drag photos, videos, and 

files from your computer and 
content from Facebook and 
Twitter directly to your Sway 
presentation.

•	 Run Sway in a web browser or 
as an app on your smartphone, 
and save presentations as 
webpages.

Figure 6: Sway site with responsive design

You can display a 
Sway presentation 
in a web browser.

Sway uses 
responsive 
design to make 
sure pages fit 
perfectly on 
any device.
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Learn to use Sway!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.

Creating a Sway Presentation
You can use Sway to build a digital �yer, a club newsletter, a vacation blog, an informa-
tional site, a digital art portfolio, or a new product rollout. A�er you select your topic 
and sign into Sway with your Microso� account, a Storyline opens, providing tools 
and a work area for composing your digital story. See Figure 7. Each story can include 
text, images, and videos. You create a Sway by adding text and media content into a 
Storyline section, or card. To add pictures, videos, or documents, select a card in the 
le� pane and then select the Insert Content button. �e �rst card in a Sway presenta-
tion contains a title and background image. 
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Figure 7: Creating a Sway site

Design and create 
Sway presentations.

To add content, select a 
card, which is designed 
to hold a particular type 
of information.

Arrange content in a Storyline, 
which contains all the text, 
pictures, videos, and other 
media in a Sway presentation.

Share and play 
published Sway sites.

After selecting a card, 
click the Insert Content 
button to add the content 
to the Sway presentation.

Adding Content to Build a Story
As you work, Sway searches the Internet to help you �nd relevant images, videos, 
tweets, and other content from online sources such as Bing, YouTube, Twitter, and 
Facebook. You can drag content from the search results right into the Storyline. In 
addition, you can upload your own images and videos directly in the presentation. 
For example, if you are creating a Sway presentation about the market for commer-
cial drones, Sway suggests content to incorporate into the presentation by displaying 
it in the le� pane as search results. �e search results include drone images tagged 
with a Creative  Commons license at online sources as shown in Figure 8. A Creative 
Commons license is a public copyright license that allows the free distribution of an 
otherwise copyrighted work. In addition, you can specify the source of the media. For 
example, you can add your own Facebook or OneNote pictures and videos in Sway 
without leaving the app.

If you have a Microsoft Word 
document containing an outline 
of your business content, drag the 
outline into Sway to create a card 
for each topic.

On the Job Now

Figure 8: Images in Sway search results

Storyline title

Drag an image to the 
picture placeholder box

Suggested images in 
the search results

Information about Creative 
Commons licensesSelect the source 

of media objects
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Designing a Sway
Sway professionally designs your Storyline content by resizing background images and 
fonts to �t your display, and by �oating text, animating media, embedding video, and 
removing images as a page scrolls out of view. Sway also evaluates the images in your 
Storyline and suggests a color palette based on colors that appear in your photos. Use 
the Design button to display tools including color palettes, font choices, animation 
emphasis e�ects, and style templates to provide a personality for a Sway presentation. 
Instead of creating your own design, you can click the Remix button, which randomly 
selects unique designs for your Sway site. 

Publishing a Sway
Use the Play button to display your �nished Sway presentation as a website. �e 
Address bar includes a unique web address where others can view your Sway site. As 
the author, you can edit a published Sway site by clicking the Edit button (pencil icon) 
on the Sway toolbar.

Sharing a Sway
When you are ready to share your Sway website, you have several options as shown in  
Figure 9. Use the Share slider button to share the Sway site publically or keep it private. 
If you add the Sway site to the Microso� Docs.com public gallery, anyone worldwide can 
use Bing, Google, or other search engines to �nd, view, and share your Sway site. You can 
also share your Sway site using Facebook, Twitter, Google+, Yammer, and other social 
media sites. Link your presentation to any webpage or email the link to your audience. 
Sway can also generate a code for embedding the link within another webpage. 

If your project team wants to col-
laborate on a Sway presentation, 
click the Authors button on the 
navigation bar to invite others to 
edit the presentation.

On the Job Now

Figure 9: Sharing a Sway site

Share button

Drag the slider button to 
Just me to keep the Sway 
site private

Send friends a link 
to the Sway site

Post the Sway 
site on Docs.com

Options di�er depending 
on your Microsoft account
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Try This Now
1: Creating a Sway Resume
Sway is a digital storytelling app. Create a Sway resume to share the skills, job experi-
ences, and achievements you have that match the requirements of a future job interest. 
Perform the following tasks:

a. Create a new presentation in Sway to use as a digital resume. Title the Sway 
Storyline with your full name and then select a background image. 

b. Create three separate sections titled Academic Background, Work Experience, and Skills, and insert text, a picture, 
and a paragraph or bulleted points in each section. Be sure to include your own picture.

c. Add a fourth section that includes a video about your school that you �nd online.
d. Customize the design of your presentation.
e. Submit your assignment link in the format speci�ed by your instructor.

2: Creating an Online Sway Newsletter
Newsletters are designed to capture the attention of their target audience. Using Sway, create a newsletter for a club, organiza-
tion, or your favorite music group. Perform the following tasks:

a. Create a new presentation in Sway to use as a digital newsletter for a club, organization, or your favorite music group. 
Provide a title for the Sway Storyline and select an appropriate background image. 

b. Select three separate sections with appropriate titles, such as Upcoming Events. In each section, insert text, a picture, 
and a paragraph or bulleted points. 

c. Add a fourth section that includes a video about your selected topic.
d. Customize the design of your presentation.
e. Submit your assignment link in the format speci�ed by your instructor.

3: Creating and Sharing a Technology Presentation
To place a Sway presentation in the hands of your entire audience, you can share a link to the Sway presentation. Create a Sway 
presentation on a new technology and share it with your class. Perform the following tasks:

a. Create a new presentation in Sway about a cutting-edge technology topic. Provide a title for the Sway Storyline and 
select a background image.

b. Create four separate sections about your topic, and include text, a picture, and a paragraph in each section. 
c. Add a ��h section that includes a video about your topic.
d. Customize the design of your presentation.
e. Share the link to your Sway with your classmates and submit your assignment link in the format speci�ed by your 

instructor.

Learn to use Sway!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.
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Introduction to Office Mix
add-in | clip | slide recording | Slide Notes | screen recording | free-response quiz  

To enliven business meetings and lectures, Microso� adds a new dimension to pre-
sentations with a powerful toolset called O�ce Mix, a free add-in for PowerPoint. (An 
add-in is so�ware that works with an installed app to extend its features.) Using O�ce 
Mix, you can record yourself on video, capture still and moving images on your desk-
top, and insert interactive elements such as quizzes and live webpages directly into 
PowerPoint slides. When you post the �nished presentation to OneDrive, O�ce Mix 
provides a link you can share with friends and colleagues. Anyone with an Internet 
connection and a web browser can watch a published O�ce Mix presentation, such as 
the one in Figure 10, on a computer or mobile device.

Bottom Line
•	 O�ce Mix is a free PowerPoint 

add-in from Microsoft that adds 
features to PowerPoint.

•	 The Mix tab on the PowerPoint 
ribbon provides tools for creat-
ing screen recordings, videos, 
interactive quizzes, and live 
webpages.

Figure 10: O�ce Mix presentation

You can view a published 
Office Mix presentation in a 
browser on any device, even 
if PowerPoint is not installed.

Display a list of 
slides with titles.

Click to continue 
to the next slide.

Adding Office Mix to PowerPoint
To get started, you create an O�ce Mix account at the website mix.o�ce.com using an 
email address or a Facebook or Google account. Next, you download and install the O�ce 
Mix add-in (see Figure 11). O�ce Mix appears as a new tab named Mix on the PowerPoint 
ribbon in versions of O�ce 2013 and O�ce 2016 running on personal computers (PCs). 

Figure 11: Getting started with O�ce Mix

Download the Office Mix free 
add-in from mix.office.com.

Click the Get Office Mix 
button to download Office 
Mix and install it as a tab 
on the PowerPoint ribbon.

Learn to use O�ce Mix!
Links to companion Sways, 
featuring videos with hands-on 
instructions, are located on  
www.cengagebrain.com.
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Figure 13: Making a screen recording

Record the action on 
the screen within the 
red dashed outline.

Select Area 
button 

Record audio while 
capturing your 
on-screen actions.

Capturing Video Clips
A clip is a short segment of audio, such as music, or video. A�er �nishing the content 
on a PowerPoint slide, you can use O�ce Mix to add a video clip to animate or illus-
trate the content. O�ce Mix creates video clips in two ways: by recording live action 
on a webcam and by capturing screen images and movements. If your computer has a 
webcam, you can record yourself and annotate the slide to create a slide recording as 
shown in Figure 12. 

When you are making a slide recording, you can record your spoken narration at 
the same time. �e Slide Notes feature works like a teleprompter to help you focus 
on your presentation content instead of memorizing your narration. Use the Inking 
tools to make annotations or add highlighting using di�erent pen types and colors. 
A�er �nishing a recording, edit the video in PowerPoint to trim the length or set 
playback options.

�e second way to create a video is to capture on-screen images and actions with or 
without a voiceover. �is method is ideal if you want to show how to use your favorite 
website or demonstrate an app such as OneNote. To share your screen with an audi-
ence, select the part of the screen you want to show in the video. O�ce Mix captures 
everything that happens in that area to create a screen  recording, as shown in Figure 13. 
O�ce Mix inserts the screen recording as a video in the slide.

Companies are using Office Mix to 
train employees about new prod-
ucts, to explain benefit packages 
to new workers, and to educate 
interns about office procedures.

On the Job Now

To make your video recordings 
accessible to people with hearing 
impairments, use the Office Mix 
closed-captioning tools. You can 
also use closed captions to sup-
plement audio that is difficult to 
understand and to provide an aid 
for those learning to read.

On the Job Now

Figure 12: Making a slide recording

Record your 
voice; also 
record video if 
your computer 
has a camera.

For best results, 
look directly at 
your webcam 
while recording 
video.

Use inking tools to write 
and draw on the slide as 
you record.

Choose a video 
and audio device 
to record images 
and sound.

Use the Slide Notes 
button to display 
notes for your 
narration.
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